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Preface

Intended Audience
Welcome to Release 12 of the Oracle Embedded Data Warehouse Install Guide.

This guide assumes you have a working knowledge of the following: 

• The principles and customary practices of your business area. 

• Computer desktop application usage and terminology 

If you have never used Oracle Applications, we suggest you attend one or more of the 
Oracle Applications training classes available through Oracle University. 

See Related Information Sources on page viii for more Oracle Applications product 
information. 

TTY Access to Oracle Support Services
Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services 
within the United States of America 24 hours a day, seven days a week. For TTY 
support, call 800.446.2398. 

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Accessibility standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading technology 
vendors to address technical obstacles so that our documentation can be accessible to all
of our customers. For more information, visit the Oracle Accessibility Program Web site 
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at http://www.oracle.com/accessibility/ . 

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise 
empty line; however, some screen readers may not always read a line of text that 
consists solely of a bracket or brace. 

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or organizations
that Oracle does not own or control. Oracle neither evaluates nor makes any 
representations regarding the accessibility of these Web sites. 

Structure
1  Introduction
2  Upgrade Tasks

Related Information Sources
This document is included on the Oracle Applications Document Library, which is 
supplied in the Release 12 DVD Pack. You can download soft-copy documentation as 
PDF files from the Oracle Technology Network at http://otn.oracle.com/documentation, 
or you can purchase hard-copy documentation from the Oracle Store at 
http://oraclestore.oracle.com. The Oracle E-Business Suite Documentation Library 
Release 12 contains the latest information, including any documents that have changed 
significantly between releases. If substantial changes to this book are necessary, a 
revised version will be made available on the online documentation CD on Oracle
MetaLink. 

If this guide refers you to other Oracle Applications documentation, use only the 
Release 12 versions of those guides.

For a full list of documentation resources for Oracle Applications Release 12, see Oracle 
Applications Documentation Resources, Release 12, OracleMetaLink Document 
394692.1.

Online Documentation 

All Oracle Applications documentation is available online (HTML or PDF).

• PDF - PDF documentation is available for download from the Oracle Technology 
Network at http://otn.oracle.com/documentation.

• Online Help - Online help patches (HTML) are available on OracleMetaLink.
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• About Documents - Refer to the About Document for the mini-pack or family pack 
that you have installed to learn about new documentation or documentation 
patches that you can download. About Documents are available on OracleMetaLink.

• Oracle MetaLink Knowledge Browser - The OracleMetaLink Knowledge Browser 
lets you browse the knowledge base, from a single product page, to find all 
documents for that product area. Use the Knowledge Browser to search for 
release-specific information, such as FAQs, recent patches, alerts, white papers, 
troubleshooting tips, and other archived documents.

• Oracle eBusiness Suite Electronic Technical Reference Manuals - Each Electronic 
Technical Reference Manual (eTRM) contains database diagrams and a detailed 
description of database tables, forms, reports, and programs for a specific Oracle 
Applications product. This information helps you convert data from your existing 
applications and integrate Oracle Applications data with non-Oracle applications, 
and write custom reports for Oracle Applications products. Oracle eTRM is 
available on OracleMetaLink.

Related Guides

You should have the following related books on hand. Depending on the requirements 
of your particular installation, you may also need additional manuals or guides.

Oracle Applications Installation Guide: Using Rapid Install: 

This book is intended for use by anyone who is responsible for installing or upgrading 
Oracle Applications. It provides instructions for running Rapid Install either to carry 
out a fresh installation of Oracle Applications Release 12, or as part of an upgrade from 
Release 11i to Release 12. The book also describes the steps needed to install the 
technology stack components only, for the special situations where this is applicable. 

Oracle Applications Upgrade Guide: Release 11i to Release 12: 

This guide provides information for DBAs and Applications Specialists who are 
responsible for upgrading a Release 11i Oracle Applications system (techstack and 
products) to Release 12. In addition to information about applying the upgrade driver, 
it outlines pre-upgrade steps and post-upgrade steps, and provides descriptions of 
product-specific functional changes and suggestions for verifying the upgrade and 
reducing downtime. 

Oracle Applications Patching Procedures:

This guide describes how to patch the Oracle Applications file system and database 
using AutoPatch, and how to use other patching-related tools like AD Merge Patch, 
OAM Patch Wizard, and OAM Registered Flagged Files. Describes patch types and 
structure, and outlines some of the most commonly used patching procedures. Part of 
Maintaining Oracle Applications, a 3-book set that also includes Oracle Applications 
Maintenance Utilities and Oracle Applications Maintenance Procedures. 

Oracle Applications Maintenance Utilities:

This guide describes how to run utilities, such as AD Administration and AD 
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Controller, used to maintain the Oracle Applications file system and database. Outlines 
the actions performed by these utilities, such as monitoring parallel processes, 
generating Applications files, and maintaining Applications database entities. Part of 
Maintaining Oracle Applications, a 3-book set that also includes Oracle Applications 
Patching Procedures and Oracle Applications Maintenance Procedures. 

Oracle Applications Maintenance Procedures:

This guide describes how to use AD maintenance utilities to complete tasks such as 
compiling invalid objects, managing parallel processing jobs, and maintaining snapshot 
information. Part of Maintaining Oracle Applications, a 3-book set that also includes 
Oracle Applications Patching Procedures and Oracle Applications Maintenance 
Utilities.

Oracle Applications Concepts:

This book is intended for all those planning to deploy Oracle E-Business Suite Release 
12, or contemplating significant changes to a configuration. After describing the Oracle 
Applications architecture and technology stack, it focuses on strategic topics, giving a 
broad outline of the actions needed to achieve a particular goal, plus the installation and
configuration choices that may be available.

Oracle Daily Business Intelligence Implementation Guide: 

This guide describes how to implement Oracle Daily Business Intelligence, including 
information on how to create custom dashboards, reports, and key performance 
indicators. 

Oracle Daily Business Intelligence User Guide: 

This guide describes how to use the preseeded Daily Business Intelligence dashboards, 
reports, and key performance indicators. 

Oracle Embedded Data Warehouse User Guide: 

This guide describes how to use Embedded Data Warehouse reports and workbooks to 
analyze performance. 

Oracle Embedded Data Warehouse Implementation Guide: 

This guide describes how to implement Embedded Data Warehouse, including how to 
set up the intelligence areas. 

Integration Repository
The Oracle Integration Repository is a compilation of information about the service 
endpoints exposed by the Oracle E-Business Suite of applications. It provides a 
complete catalog of Oracle E-Business Suite's business service interfaces. The tool lets 
users easily discover and deploy the appropriate business service interface for 
integration with any system, application, or business partner. 

The Oracle Integration Repository is shipped as part of the E-Business Suite. As your 
instance is patched, the repository is automatically updated with content appropriate 
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for the precise revisions of interfaces in your environment. 

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data unless 
otherwise instructed. 

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of your 
data and you lose the ability to audit changes to your data. 

Because Oracle Applications tables are interrelated, any change you make using an 
Oracle Applications form can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your tables 
get out of synchronization with each other, you risk retrieving erroneous information 
and you risk unpredictable results throughout Oracle Applications. 

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps track 
of who changes information. If you enter information into database tables using 
database tools, you may store invalid information. You also lose the ability to track who
has changed your information because SQL*Plus and other database tools do not keep a
record of changes. 
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1
Introduction

This chapter covers the following topics:

• Overview of E-Business Intelligence

• Overview of Embedded Data Warehouse

• E-Business Intelligence Architecture 

• Embedded Data Warehouse Architecture

Overview of E-Business Intelligence
In becoming e-businesses, organizations have streamlined their internal processes to 
win new customers and to gain a larger share of their existing customers' business. 
New, internet-enabled, enterprise application suites and electronic market places are 
reducing inefficiencies across supply chains while providing new opportunities to 
improve customer relationships. As organizations adopt these new solutions, the need 
to make decisions faster has also increased. To remain competitive, every organization 
must empower more people to make informed decisions, without the need for long 
approval or review cycles. 

To meet this challenge, organizations must provide the relevant business information 
and analysis tools that every manager or project team needs to quickly understand 
what is happening, to be able to analyze alternatives, and to take action. Business 
intelligence applications are available to provide the data and analysis required to make
these decisions, but most business intelligence products are not integrated with 
operational systems. Because the business processes underlying source applications are 
always changing, traditional business intelligence applications cannot easily gather the 
necessary data or transform it into useful management information.

The Oracle Embedded Data Warehouse (EDW) provides a simple and powerful 
framework for delivering information, from internal applications and external sources, 
to end-users across the enterprise. EDW unlocks the value of information, held in 
operational systems, by automatically collecting, aggregating and transforming source 
data, to provide secure access and a unified view of the entire organization. With the 
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Business Intelligence System applications, everyone has immediate access to accurate 
and timely data to make faster and more informed decisions, which leads to a positive 
impact on bottom line results.

Overview of Embedded Data Warehouse
EDW is a foundation technology for Oracle E-Business Intelligence. This ready-to-run, 
end-to-end solution provides an open schema and extensible data warehousing 
architecture, powered by robust data warehousing tools. EDW:

• Gives users a unified view of the enterprise with its cross-functional analysis 
capabilities

• Leverages a common dimension model which enables seamless cross-functional 
analysis across the entire enterprise

• Includes fact tables from 7 intelligence areas: Financials, Projects, Purchasing, 
Manufacturing, Marketing, Human Resources, and Supply Chain

• Includes pre-built collections for Oracle E-Business Suite and by using Oracle 
Warehouse Builder, customers can map non-Oracle sources

• Provides shorter time-to-benefit with its pre-defined enterprise schemas and 
hierarchies, and pre-built data collection and integration programs

EDW, the enabling technology of Oracle E-Business Intelligence, unleashes the power of
e-business insight, not just information.

E-Business Intelligence Architecture 
E-Business Intelligence is a multi-tiered architecture. 

The first tier, the database tier, provides the foundation technology. The database tier 
can be implemented as a transactional (OLTP) or a warehouse (OLAP) schema. The 
transactional schema provides users with real-time report data. The warehouse schema 
provides users with summarized data that supports more complex reporting and 
decision making. The type of schema you choose determines the type of content that is 
available to your users.

The second tier, the applications tier, provides the load balancing and business logic. It 
processes requests from the third tier (client tier) and sends results from the database 
tier to the client tier. 

The third tier, the client tier, supports user activities such as reporting from the web, 
and administration.

This guide assumes that you are implementing the warehouse schema. 
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Note: For more information on Oracle Applications and multi-tier 
architecture, see Oracle Applications Concepts.

Embedded Data Warehouse Architecture
EDW divides your data between two types of systems: one or more source systems and 
one target system.

A source system can be any Oracle Applications system, non-Oracle system running on 
an Oracle database, or legacy database application that provides data to the warehouse. 
You can use one or more source systems to provide data to the target system. 

The target system is the runtime warehouse. There is only one target system. It 
integrates data from multiple source systems, transforms the data, and makes it 
available in a star schema design. The star schema design supports complex user 
reporting and decision making. 

Embedded Data Warehouse Components
The following section describes the various components that reside on the source 
systems and the target (warehouse) system.

Source System Components
Source systems can be any Oracle E-Business Suite system; non-Oracle system running 
on an Oracle database; or legacy database application that provides data to the 
warehouse. Each source system must contain the following components.

• Database links: Database links are used to connect the source system to the 
warehouse and from the warehouse to the source system. 

• Interface tables: For EDW, source system data is put into interface tables before it is
pushed to the warehouse.

• Collect programs: Collect programs determine how to extract and transform source
data for the warehouse. Collect programs use the database links to transfer data 
from the interface tables to the warehouse and from the warehouse to the source 
system.

• Concurrent Manager: The concurrent manager coordinates the processes generated
by users' requests to run various data-intensive programs. 

• Web Browser: A web browser is used with Oracle E-Business Suite source systems. 
This is only necessary for Oracle E-Business Suite.

These components must be installed and set up on each source system. 
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Target System Components
The target system is an Oracle E-Business Suite with an Oracle 8i database or higher. 
The target system summarizes data from the various source systems into a data 
warehouse (from this point forward, this document will refer to the target system as the
warehouse). The warehouse contains fact tables, dimension tables, APIs, and other 
supporting utilities and objects. It must also contain the following components:

• Load Programs: Load programs use the EDW metadata to determine how to move 
data into the warehouse. Load programs transfer data from interface tables to 
warehouse schema.

• Database Links: Database links are used to connect the source system to the 
warehouse and from the warehouse to the source system. 

• EDW Metadata: The EDW metadata defines the contents of the runtime warehouse:
the facts, dimensions, and other objects. The loader engine uses the metadata define
how to move data into the warehouse schema. The reporting and analytical tools 
also use the metadata. 

• Oracle Discoverer End User Layer: The Oracle Discoverer End User Layer (EUL) is 
a schema that sits on the warehouse database. This schema is used to access the 
workbooks. Workbooks and the EUL must reside on the database tier of the 
warehouse. 

• Oracle Discoverer Workbooks: Workbooks enable users to analyze the 
summarized data in the warehouse. Workbooks access data through the Oracle 
Discoverer EUL. Workbooks and the EUL must reside on the database tier of the 
warehouse. 

• Oracle Warehouse Builder Repository: The Oracle Warehouse Builder (OWB) 
repository resides on the database tier of the warehouse. This repository stores the 
EDW metadata. 

• Interface Tables: For EDW, source system data is loaded into interface tables before
it is transformed into the star schema on the warehouse.

• Concurrent Manager: The concurrent manager coordinates the processes generated
by users' requests to run various data-intensive programs. 

• Forms Server: The Forms Server is automatically installed as part of the Oracle 
E-Business Suite.

• Oracle Discoverer 10g R1 Web Client: The Oracle Discoverer 10g Web Client is 
installed as a separate application. The client contains a web browser with the 
Oracle Discoverer Web Client plug-in that executes the workbooks. 
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• Self Service Web Applications: Self Service Web Applications is automatically 
installed as part of the Oracle E-Business Suite.

• Zip utility: This utility is used to extract compressed files.

• Oracle Warehouse Builder Client: The OWB client provides front-end access to the 
OWB repository. 

• Oracle Discoverer Bridge Client: The Oracle Discoverer Bridge client is used to 
create the EUL from the EDW metadata. The bridge is installed as part of the typical
Oracle Warehouse Builder install. The bridge can reside on the same physical 
machine as the OWB client.

• Oracle Discoverer Administration Client: The Oracle Discoverer Administration 
client is installed as a separate application. The client is used for administration of 
the Oracle Discoverer EUL. You use this client to import the EUL and configure 
security for Oracle Discoverer. 

• Web Browser: A web browser is used to view warehouse data.

• Performance Management Framework Components: The following is a list of the 
components that comprise the Performance Management Framework.

• Presentation components: The Performance Management Viewer allows end 
users to display graphs from the Performance Management Viewer reports. 
End users can choose a report and parameters for display.

End users can choose measures and parameters. The actual values will display, 
with red color coding if the actual value falls outside of the tolerance range. The
values of the measure are calculated through the processing of Alerts. 

Through the Performance Management Viewer, end users have access to a set 
of pre-built reports that are specifically tailored to intelligence users. These 
reports provide an intuitive user interface and features aimed at the novice end 
user. Note that previous versions of Oracle E-Business Intelligence used Oracle 
Reports to define and render reports. In this release, Performance Management 
Viewer technology is used to define and render reports.

Through Oracle Workflow, users receive notifications. Notifications alert users 
to out of tolerance situations for measures with targets. 

• Definition components: The AK Repository is a metadata repository used for 
the definition of application common data. The AK Repository is used to define 
Performance Management Viewer reports and performance measures. This 
definition contains layout information for the reports and establishes the source
of actual values for both the reports and performance measures. 

The Performance Management Framework contains a set of forms to define 
performance measures and the dimension levels. These forms allow 
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administration users to assign the dimensions, security, corrective actions and 
automated target retrieval. Note that a measure also needs setup in the AK 
repository to enable the retrieval of actual values. 

• Responsibilities: The following responsibilities are used for setting up the 
Performance Management Framework: Performance Management Framework 
(Full Access), Performance Management Framework (Targets Access), BIS 
Super User. 

The following responsibilities contain Performance Management Viewer 
Reports: Purchasing Intelligence - Embedded Data Warehouse, Supply Chain 
Intelligence - Embedded Data Warehouse, Manufacturing Intelligence - 
Embedded Data Warehouse.

• Data components: To construct reports and performance measures , 
intelligence teams have built a set of views on top of the EDW fact tables. These 
views are optimized for use by the Viewer Reports and Performance Measures.

The Performance Management Framework contains a set of forms for use in 
entering and maintaining target information on performance measures. This 
includes target values, tolerance ranges and target owners.

• Processing components: Through the Performance Management Framework, 
administration users can schedule alerts and target users can subscribe to the 
notifications. Schedule Alerts will send notifications to target owners and 
update data for presentation on the performance measure portlet. Note that 
previous versions of E-Business Intelligence applications used Oracle Alerts to 
achieve the alerting functionality. This release uses E-Business Intelligence 
alerting. 
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2
Upgrade Tasks

This chapter covers the following topics:

• Overview of Upgrading EDW

• Verify Prerequisites

• Hardware Prerequisites

• Software Prerequisites

• Upgrading the Oracle Warehouse Builder Repository

• Migrate OWB Repository

• Upgrade OWB 9i Repository

• Upgrade Embedded Data Warehouse EUL

• Upgrade Custom Workbooks

• Configuring Security

• Grant Users/Responsibilities Access to Business Areas

• Transfer EDW Discoverer Contents to the Administrative Client

• Backup Source Systems and Warehouse

Overview of Upgrading EDW
This chapter describes how to upgrade EDW from Oracle E-Business Suite Release 11i 
to Oracle E-Business Suite Release 12. 

To avoid unexpected delays in the upgrade, please read through this entire section and 
familiarize yourself with the upgrade process before you begin. 

It is highly recommended that this upgrade be performed by an Oracle Applications 
database administrator in cooperation with the implementation team.
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Important: Customers are strongly encouraged to install and 
implement Oracle Daily Business Intelligence instead of Oracle 
Embedded Data Warehouse. Customers who are interested in installing
EDW, should review About Oracle Embedded Data Warehouse on Oracle 
MetaLink (Note: 258899.1). 

Verify Prerequisites
Before you begin to upgrade EDW, you must verify that all hardware and software 
prerequisites have been met.

This section contains the following topics.

• Hardware Prerequisites, page 2-2

• Software Prerequisites, page 2-3

Hardware Prerequisites
To successfully complete the install, you must have the following hardware available.

Source Systems
For information on hardware requirements for your Release 12 source systems, see the 
installation documentation for the respective system.

Warehouse
For the hardware requirements for the database, see Oracle 10g installation 
documentation. 

For the hardware requirements and supported platforms for Oracle Discoverer, see 
Oracle Discoverer 10g installation documentation. 

Administrative Client
The Oracle Warehouse Builder Client requires one of the following Windows operating 
systems: Windows NT/2000/XP. The OWB Client is installed into Oracle 10g home on a 
Windows NT/2000/XP machine. The Windows NT/2000/XP server should have at least 1
GB of RAM and 2 GB of space for installing the OWB Client and converting the OWB 
metadata repository.
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Software Prerequisites
To successfully complete the install, you must have the following software available on 
the source system and warehouse servers.

Source Systems
You must have the following standard source system. For information on the standard 
install, see the appropriate installation documentation.

• Oracle Applications Release 12

Warehouse
You must have the following standard warehouse system. For information on how to 
install the warehouse system, see the appropriate installation documentation.

• Oracle Applications Release 12

For RDBMS 8i or higher, update your init.ora parameter file with the following 
initialization parameters:
star_transformation_enabled = true

Administrative Client
The following software must be installed on the Administrative Client.

• Oracle 10g Release 1 Warehouse Builder Client with Common Warehouse Metadata
Transfer Wizard

• Oracle Discoverer 10g Release 1 Administration Edition Client (version 10.1.2.0.1 or 
higher)

• Oracle Discoverer 10g Release 1 User Edition Client (version 10.1.2.0.1)

Note: Use a separate machines to install the Oracle 10g Release 1 
Warehouse Builder Client software and the Oracle Discoverer 10g 
Release 1 Clients. In all cases machines with either Warehouse Builder 
or Discoverer software installed will be referred as Administrative Client 
throughout this document.
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Upgrading the Oracle Warehouse Builder Repository
Note: Oracle Embedded Data Warehouse Release 12 is certified with Oracle 
Warehouse Builder Repository 10g Release 1 only.

If you are upgrading EDW Release 3.x / OWB 2.1.1 or 4.0 / OWB 2.1.1 
you must first upgrade to EDW Release 4.2 on Oracle E-Business Suite 
11i. See: Oracle E-Business Intelligence Embedded Data Warehouse Install 
Guide, Release 11i.

The following upgrade paths are supported.

From Tasks

EDW 3.x /4.0

OWB 2.1.1

Mirgrate OWB Repository from 2.1.1 to 9i

Upgrade the OWB 9i Repository

Migrate OWB Repository from 9i to 10gR1

EDW 4.1

OWB 9.0.3.x

Upgrade the OWB 9i Repository

Migrate OWB Repository from 9i to 10gR1

EDW 4.2

OWB 9.2.0.x

Migrate OWB Repository from 9i to 10gR1

Migrate OWB Repository
Follow the instructions in Oracle E-Business Intelligence Embedded Data Warehouse Install 
and Upgrade Guide, Release 11ifor information on migrating the Oracle Warehouse 
Builder Repository.

Upgrade OWB 9i Repository
Follow the instructions in Oracle Warehouse Builder Installation and Configuration Guide 
10g Release1 to upgrade EDW Metadata Repository.

Upgrade Embedded Data Warehouse EUL
Note: If you created any custom workbooks, make sure you preserve all
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the customizations before you proceed with the EUL upgrade.

Generate the EDW EUL EEX File
To generate the EEX file:
1. Log on to the OWB Administrative Client machine and run OWB as an owner of 

the EDW OWB repository schema. For example, EDWREP/EDWREP@TST115. The 
Project Name field is automatically populated with "EDWPRJ". 

2. Choose the OK button.

3. The EBI Assistant displays automatically. Choose the Close button to view the OWB
main page.

4. From the Projects menu, choose Metadata Export > Bridge. The CWM Transfer 
Wizard appears.

Configure the wizard to generate the EDW EUL. When using the wizard, ensure 
that "Oracle Discoverer" is the selected target product on "Metadata Source and 
Target Identification" window and that the following values are provided for the 
"CWM Transfer Parameters" window.

CWM Transfer Parameters

Transfer Parameter Value

OWB Exported Business Areas All Business Areas

OWB Translated Language English_United States

Discoverer EUL Owner EDWEUL_US

Discoverer Schema Owner APPS

Dimensional Reuse True

Discoverer Output File edweul.exe

Log Level Information

Once you have verified the preceding parameter values, you have generated the EDW 
EUL and you can proceed with the EUL import.
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Import the EDW EUL EEX File
To import the EEX file:
1. Copy the edweul.eex file to the Administration Client machine.

2. Run the Discoverer Administration Client and connect as the EUL owner.

3. Choose File > Import.

4. Choose edweul.eex from the list of values and choose Add. 

5. Ensure that you select the following import options:

• Refresh the object

• By Identifier

• Always take ownership of imported workbooks

6. Choose Start. The import process begins.

7. After the import is over, click the Finish button and wait until SQL regeneration is 
done.

Upgrade Custom Workbooks
If you have any custom workbooks, you must upgrade them after you update the EDW 
EUL.

To upgrade custom workbooks, do the following:

1. Log into the Discoverer 10g Administrative Client machine.

2. Start Discoverer 10g User Edition and open a custom workbook.

3. Validate the custom workbook by name.

4. Save the workbook in the database.

5. Repeat steps 1 through 4 for each custom workbook.

Configuring Security
Once you have upgraded the EUL and workbooks, you must use Oracle Discoverer 10g 
to configure security for your workbooks. Configuring security limits your users' ability
to access certain workbooks. 
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Note: The steps listed in this section are the mandatory security steps 
that you must define to complete the EDW upgrade. Other ways of 
implementing security in the warehouse are explained in the Oracle 
Embedded Data Warehouse Implementation Guide. Please ensure that you 
verify with your implementation team the types of security that you 
want to implement.

To configure security using Oracle Discoverer 10g, complete these steps in the following
order.

1. Grant Users/Responsibilities Access to Business Areas, page 2-7

2. Transfer EDW Discoverer Contents to the Administrative Client, page 2-9

Grant Users/Responsibilities Access to Business Areas
Once you grant the users/responsibilities access to Oracle Discoverer, you must grant 
them access to the applicable business areas. You can also create new responsibilities if 
the ones provided do not meet your needs.

Responsibilities and Business Areas 

Responsibility Business Area Has Access To…

Financials Intelligence - 
Enterprise Data Warehouse

Payables Intelligence business
area

Access to Business 
Intelligence System Payables 
Business Area and 
Workbooks

Financials Intelligence - 
Enterprise Data Warehouse

Revenue Intelligence business
area

Access to Business 
Intelligence System 
Receivables Business Area 
and Workbooks

Financials Intelligence - 
Enterprise Data Warehouse

Project Intelligence business 
area

Access to Business 
Intelligence Projects Business 
Area and Workbooks

Human Resources 
Intelligence - Enterprise Data 
Warehouse

Workforce Planning business 
area

Access to Business 
Intelligence Workforce 
Planning Business Area and 
Workbooks
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Responsibility Business Area Has Access To…

Manufacturing Intelligence - 
Enterprise Data Warehouse

Manufacturing Intelligence 
business area

Access to Business 
Intelligence System 
Manufacturing Business Area 
and Workbooks

Manufacturing Intelligence - 
Enterprise Data Warehouse

Operations Intelligence Access to Business 
Intelligence System 
Operations Business Area and
Workbooks

Purchasing Intelligence - 
Enterprise Data Warehouse

Purchasing Intelligence 
business area

Access to Business 
Intelligence System 
Purchasing Business Area and
Workbooks

Purchasing Intelligence - 
Enterprise Data Warehouse

Purchasing Intelligence 
extended business area

Access to Business 
Intelligence System 
Purchasing Extended 
Business Area and 
Workbooks

Supply Chain Intelligence - 
Enterprise Data Warehouse

Supplier Chain Intelligence 
business area

Access to Business 
Intelligence System Supply 
Chain Business Area and 
Workbooks

To grant users/responsibilities access to Business Areas:

1. In Oracle Discoverer 10g Administration Edition client, choose Tools -> Security.

2. Select the responsibility.

3. Grant the responsibility access to the business areas, as shown in the table above.

4. If the responsibility needs administrative access to the business area, enable the 
Allow Administration check box.

5. Connect to Discoverer 10g Administration Edition as a valid Applications user with
a valid responsibility (for example, "SYSADMIN:System Administrator"), which has
been granted access to Discoverer 10g Administration Client and validate your 
folders by choosing Choose View -> Validate Folders.

For more information on how to grant access and define EUL security, see the Oracle 
Discoverer 10g Administration Guide.
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Transfer EDW Discoverer Contents to the Administrative Client
To transfer EDW Discoverer contents:
1. Decide on one of the following methods to access the Discoverer EEX:

• Map your Oracle Applications AU_TOP to your Administrative Client and 
execute adupdeul.sh from the \discoverer directory on the mapped network 
drive. 

• Transfer $AU_TOP/discover directory and its contents (including 
subdirectories) to a temporary directory on your Administrative Client and 
execute adupdeul.sh from the temporary directory.

Note: Ensure that the MKS Toolkit is installed on the 
Administrative Client.

2. Load the EDW Discoverer contents into the EDW EUL by doing the following:

1. Open MS-DOS command prompt window.

2. Change to the mounted directory / temporary directory where the 
$AU_TOP/discover directory contents are located.

3. Import EDW Discoverer workbooks and extended EUL contents by executing the 
following command:
> sh adupdeul.sh connect="<APPS User>:<Valid Apps responsibility 
name>"/<Apps user password> <two_task> resp=<APPS responsibility 
name> gwyuid=applsyspbub/pub fndnam=apps secgroup="Standard" 
topdir=<top level directory where discoverer files are available> 
language=<comma separated list of language codes> eulprefix=EUL 
prefix (for ex: EDWEUL) eultype=EDW mode=complete exedir=<directory 
where discoverer executables are located> logfile=adupdeul.log 

For example:
d:\temp> sh adupdeul.sh connect="sysadmin:System 
Administrator/sysadmin@apps115 resp="System Administrator" 
gwyuid=applsyspub/pub fndnam=apps secgroup="Standard" topdir=d:/temp
language=us eulprefix=EDWEUL eultype=EDW mode=complete 
exedir=d:/orant/discvr4 logfile=d:/temp/adupdeul.log

4. Check adupdeul.log file for any errors. 

Backup Source Systems and Warehouse
Congratulations! You have successfully completed upgrading EDW. 

Once you complete the upgrade, it is highly recommended that you backup the data on 
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both your source and warehouse systems to ensure that you can always return to this 
fresh-upgrade state. This step is optional.
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